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Read This First
Disclaimer

• While every effort has been made to ensure that the information contained in 
this guide is accurate and complete, no liability can be accepted for any 
errors or omissions. Canon reserves the right to change the specifications of 
the hardware and software described herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a 
retrieval system, or translated into any language in any form, by any means, 
without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost 
data due to mistaken operation or malfunction of the camcorder, the 
software, memory cards (miniSD Cards), personal computers, or peripheral 
devices, or due to use of a memory card not formatted by a Canon 
camcorder.

Trademark Acknowledgments
• QuickTime is a trademark of Apple Computer, Inc.
• Microsoft® and Windows® are either registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.
• miniSD is a trademark of SD Card Association.
• Other names and products not mentioned above may be registered 

trademarks or trademarks of their respective companies.
© Canon Inc. 2005 All rights reserved.

Safety Precautions
Do not play the supplied CD-ROM(s) in any CD player that does not support 
data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player) 
could damage the speakers. It is also possible to suffer from hearing loss from 
listening with headphones to the loud sounds of a CD-ROM played on a music 
CD player.

Checking Supplied Accessories
Use the following accessories to download recorded still images from a disc or a 
memory card to your computer.
• IFC-300PCU USB Cable • DIGITAL VIDEO SOLUTION DISK

The explanations in this manual use mainly Windows XP screen shots. The 
steps and windows may vary depending on your computer and the version of 
software.
3Read This First
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System Requirements
Please install the software on a computer meeting the following minimum 
requirements.

Proper operation is not guaranteed on a dual CPU PC or on a user-built PC. 
Proper operation is not guaranteed on any particular system, even if it meets 
the requirements outlined above. 
A CD-ROM drive is required to install the software.

In this Instruction Manual, product names are abbreviated as follows:

OS: Windows 98 (Second Edition)
Windows Me
Windows 2000 (Service Pack 4)
Windows XP Home Edition or Professional
(Service Pack 1 or 2)
* Proper operation is not guaranteed on an OS that has 

been upgraded from a previous version. 
Computer Model: Computers that come with above OS preinstalled and 

have built-in USB ports.
CPU: Pentium 500 MHz or better
RAM: Windows 98/Windows Me: 128 MB or more

Windows 2000/Windows XP: 256 MB or more
Interface: USB: only preinstalled Windows 98/Windows Me/Windows 

2000/Windows XP systems with built-in USB ports 
Free Hard Disk Space: • Canon Utilities

- ZoomBrowser EX: 250 MB or more  (Including the 
PhotoRecord printing program)

- PhotoStitch: 40 MB or more
• Canon DV TWAIN Driver: 25 MB or more
• Canon DV WIA Driver: 25 MB or more

Display: 1024 × 768 pixels or better/High Color (16 bit) or better

Microsoft® Windows® 98 Second Edition: Windows 98
Microsoft® Windows® Millennium Edition: Windows Me
Microsoft® Windows® 2000 (Service Pack 4): Windows 2000
Microsoft® Windows® XP Home Edition or Professional
(Service Pack 1 or 2): Windows XP
System Requirements
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What is Digital Video Software
The following software will be installed by installing the Digital Video Software.

ZoomBrowser EX
• Viewing downloaded still images
• Categorizing, organizing, and searching large volumes of still images
• Editing still images
• Changing the data for still images and save them as new files
• Viewing still images in a slide show
• Adding sound to a still image

CameraWindow
• Downloading still images from a disc or a memory card to your computer
• Viewing still images recorded on a disc or a memory card
• Applying DPOF (Digital Print Order Format) settings to the still images 

recorded on a memory card

PhotoStitch
Merging a series of overlapping still images into a single, seamless panorama

PhotoRecord
• Printing still images with background, frame, title and comments
• Printing indexes
• Creating still image albums

USB Driver
• Driver software that enables you to download still images from a disc or a 

memory card to a computer. Users of Windows XP do not need to install this 
driver software. An OS standard driver will be installed automatically.

• Windows 98/Windows 2000: Canon DV TWAIN Driver
• Windows Me: Canon DV WIA Driver

This instruction manual explains how to install the software, what you can do 
with the main features and how to operate them. For more detailed operational 
instructions, refer to the Help menu of each software program. 
5What is Digital Video Software
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Installing the Digital Video Software
Be sure to install the Digital Video Software before connecting the 
camcorder to the computer.
Users of Windows 2000 or Windows XP must first log in as an Administrator 
to install programs. 

Windows XP Users:
Your digital video camcorder is equipped with the standard Picture Transfer 
Protocol (PTP). This protocol enables you to download still images by simply 
connecting the camcorder to a computer with the USB cable (the software such 
as the [Scanner and Camera Wizard] starts automatically).
However, please note that there are several limitations to downloading still 
images with this method. To avoid these problems, install ZoomBrowser EX to 
download still images.

- It may take a few minutes, after connecting the camcorder, until you can 
download still images.

- Still images protected on the camcorder may lose this setting once they are 
downloaded to the computer.

1 Check a camcorder is not connected to the computer.
While a camcorder is connected to the computer, the software cannot be 
installed normally. If a camcorder is connected, detach the USB cable from the 
computer.

2 Close any programs that are running. 

3 Set the DIGITAL VIDEO SOLUTION DISK in the computer’s 
CD-ROM drive.

If the installer panel does not open automatically, use the following procedures 
to display it. 

- Windows 98/Windows Me/Windows 2000:
1) Double-click the [My Computer] icon.
2) Right-click the CD-ROM icon and select [Open] from the displayed 

menu. 
3) Double-click the [SETUP.exe] icon. 

- Windows XP:
1) Select [My Computer] from the [start] menu.
2) Right-click the CD-ROM icon and select [Open] from the displayed 

menu.
3) Double-click the [SETUP.exe] icon.

Depending on the setting of your computer, the file extension “.exe” may not 
appear. 

4 Select your language.
Installing the Digital Video Software
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5 Click Digital Video Software [Install].

If the following dialog appears, click [Restart] to restart the computer. After 
restarting the computer, installation automatically continues.

6 Click [Next].

Installer Panel  
7Installing the Digital Video Software
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7 Select [Easy Installation] and click [Next].
To install the software individually, select [Custom Installation]. When you select 
[Custom Installation], select a USB driver. (Windows XP: The USB driver 
supplied with the Windows operating system is used. You do not need to install 
a USB driver.)
• Windows 98/Windows 2000: Canon DV TWAIN Driver
• Windows Me: Canon DV WIA Driver

8 Select your country/region and click [Next].

9 Read the license agreement and click [Yes].

10Review the installation settings and click [Next].
• Installation starts.
• If the “Digital signature not found” message appears, click [Yes].
Installing the Digital Video Software
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11When installation is complete, select [Yes, I want to restart 
my computer now.] and click [Finish]. 

12When the computer has restarted and the regular desktop 
screen is displayed, remove the DIGITAL VIDEO SOLUTION 
DISK from the CD-ROM drive.

When installation is complete, remove the DIGITAL VIDEO SOLUTION DISK 
before you connect the camcorder to the computer.

Windows 98/Windows Me/Windows 2000: At this point, the files for the TWAIN 
Driver or WIA Driver have only been copied to your computer. To download still 
images via USB connection, finish installing the TWAIN Driver or the WIA 
Driver. For details, see step 5 ( 10) in Connecting the Camcorder to a 
Computer.
9Installing the Digital Video Software
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Before Downloading Still Images

Connecting the Camcorder to a Computer
Be sure to install the Digital Video Software before you connect the 
camcorder to the computer.
Make sure the camcorder is being powered using the power adapter before 
connecting it to a computer.
Connect the USB cable directly to one of the computer’s main USB ports. 
The interface may not function correctly if the camcorder is connected via a 
USB hub.
The connection may not operate correctly if you are using other USB 
devices, excluding USB mice or keyboards, at the same time. If this occurs, 
disconnect the other devices from the computer and try reconnecting the 
camcorder.
Do not connect two or more camcorders to the computer. The camcorders 
may not operate normally.
Never allow the computer to go into standby (sleep) mode while a 
camcorder is connected via the USB interface. 

Refer to your computer manual for the location of the computer’s USB ports. 
See your camcorder instruction manual for how to connect the camcorder to 
the computer and how to change the media setting (MEDIA SEL. ) in the 
SYSTEM SETUP menu.

1 Insert a disc or a memory card containing images into the 
camcorder.

2 Connect the power adapter to the camcorder. 

3 Turn the power switch to PLAY and move the /  switch 
to .

Wait until the camcorder’s access indicator stops flashing.

4 To download still images on the disc, select [DISC] in the 
SYSTEM SETUP menu.
To download still images on the card, select [CARD] in the 
SYSTEM SETUP menu.

5 Attach the supplied USB cable to the computer’s USB port 
and the camcorder’s USB Terminal.

• The first time you connect the camcorder to the computer:
- Installation of the DV TWAIN Driver (Windows 98/Windows 2000) or the DV 

WIA Driver (Windows Me) starts.
- If the “Digital signature not found” message appears, click [Yes].
- If you are prompted to restart the computer, restart the computer.
0 Before Downloading Still Images
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• Windows 98/Windows 2000/Windows XP: A window appears allowing you to 
select an application program to start.
Windows Me: The Scanners and Cameras Wizard starts. Click [Cancel] to 
close the Wizard.

• For instructions on how to start ZoomBrowser EX and download still images to 
the computer, see Downloading Still Images (ZoomBrowser EX) ( 12).

USB CableUSB Terminal 
on the Camcorder

 Camcorder End Computer End 

USB Port on 
the Computer
11Before Downloading Still Images
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Downloading Still Images (ZoomBrowser EX)
Proper operation when connecting to a computer or printer cannot be 
guaranteed if the disc inserted into the camcorder was recorded or used in a 
non-Canon digital device.
Observe the following precautions when the camcorder’s access indicator is 
flashing. Failure to do so may cause disc or memory card data to become 
corrupted.
- Do not open the disc or memory card cover, remove the disc or memory 

card or detach the USB cable.
- Do not turn off the camcorder or the computer.
- Do not change the position of the power switch or the /  switch.
Images recorded onto the disc, memory card or downloaded to the hard disk 
are important original data files. Create a copy of the file first before working 
on it on your computer.
For Windows XP Users:
- Do not rotate the image in the [Windows Picture and Fax Viewer] or in the 

explorer view. The data for the original image will be changed and the 
image can no longer be displayed in ZoomBrowser EX or on the 
camcorder. 

- If the Server Busy window appears when you connect the camcorder to the 
computer, click [Retry].

You cannot connect the camcorder to a computer if the disc or memory card 
contains more than 1800 images. For best performance, we recommend 
keeping the number of images on the disc or memory card below 100 when 
downloading images to the computer. When using a memory card, please 
use a card reader to download the still images; for the disc, please use your 
computer’s DVD drive. When using the DVD drive to download the images 
recorded on the disc, it is necessary to insert a finalized disc.
- You cannot record any new images on the finalized DVD-R disc or 

unfinalize it.

For instructions on how to connect a card reader/writer, see Using a Card 
Reader/Writer ( 19).
2 Downloading Still Images (ZoomBrowser EX)
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Starting CameraWindow

1 Connect the camcorder to the computer ( 10).

2 Select [Canon CameraWindow] and click [OK].
• If a camcorder and card reader are connected at the same time, a dialog 

appears allowing you to select the camcorder model. Confirm that [Canon 
Camera] or your camcorder model name is displayed and click [OK].

• The Camera Control window opens.
• If the window does not appear or if “PC CONNECT” does not appear on the 

camcorder screen, click the Windows [start] menu and select [All Programs], 
[Canon Utilities], [CameraWindow] and [CameraWindow].

If the camcorder is already connected to the computer, you can start the 
CameraWindow and display the Camera Control window by clicking [Acquire 
& Camera Settings] followed by [Acquire Images] in the ZoomBrowser EX 
Main Window.
The Remote shooting function is not supported by your camcorder.

Camera Control window 
Still images will be downloaded 
to the computer, and 
ZoomBrowser EX starts. 

Still images in the camcorder 
are displayed allowing you to  
select images. 

Placing a check mark here makes 
the Camera Control window to open 
automatically the next time you 
connect the camcorder.

Specify the still image type to be 
downloaded and the destination folder. 
13Downloading Still Images (ZoomBrowser EX)
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Using the Computer to Download Still Images
You can select a downloading method in the Camera Control window.

Auto-Downloading

1 Click [Starts to download images] in the Camera Control 
window.

• For instructions on how to set the Auto-download settings, see Auto-
Downloading Settings ( 14).

• Click [Finish] to close the Camera Control window after downloading images.

Auto-Downloading Settings
Select the setting for downloading images by operating your computer. You can 
change the image type and the destination folder.

1 In the Camera Control window, click the [Acquire Images] 
tab and click [Preferences].
4 Downloading Still Images (ZoomBrowser EX)
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2 Select [Change auto download settings] and click [Next].

3 Select the image type to be downloaded and click [Next].

The still images recorded on the disc will not be marked as “already 
transferred” after downloading.
15Downloading Still Images (ZoomBrowser EX)
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4 Specify the destination folder settings and click [Next].

5 Specify a process to perform after the image is downloaded.

Click this button 
to specify the 
destination folder.  

Destination Folder  

Select to specify  
the name of the 
subfolder.
6 Downloading Still Images (ZoomBrowser EX)
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Below window will be displayed when you select [Perform selected processes 
consecutively] (You can redisplay the window by clicking [Select]). Select a 
process to perform after the image is downloaded, and click [OK].

6 Click [Finish].

Placing a check mark  
here makes images in  
the camcorder to be 
automatically downloaded  
when the camcorder is 
connected.
17Downloading Still Images (ZoomBrowser EX)
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Downloading the Selected Still Images from the 
CameraWindow

1 Click [Lets you select and download images] in the Camera 
Control window.

The CameraWindow opens.

2 In the CameraWindow, select the image you wish to 
download and click [Download pictures].

• Clicking on 2 images while holding down the [Shift] key selects also all images 
between the 2 images.

• Clicking on different images while holding down the [Ctrl] key selects multiple 
images.

If [Night], [SUPER NIGHT], [SPOTLIGHT] or [SUNSET] are chosen as 
recording programs or if [SOFT SKIN DETAIL] is chosen as an image effect, 
this information may not be displayed in the Image Information.
[Delete] from the [Edit] menu and  will not be active when transferring the 
still images recorded on the disc.

A blue frame appears  
around the selected image.

Image Information
8 Downloading Still Images (ZoomBrowser EX)
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3 Confirm the settings and click [Starts Download].
ZoomBrowser EX starts, and the downloaded images appear in the Main 
Window. 

Using a Card Reader/Writer
The basic operations of ZoomBrowser EX are the same as when you connect the 
camcorder to the computer. Follow the procedure below to open the 
CameraWindow. For instructions on how to connect the card reader/writer, 
please refer to its manual.

If your card reader/writer does not support miniSD cards, please purchase an 
appropriate adapter for the card.

1 Insert a memory card containing images recorded with the    
camcorder into the reader.

2 Windows 98/Windows Me/Windows 2000: Click the Windows 
[Start] menu, and select [Programs], [Canon Utilities], 
[CameraWindow] and [CameraWindow].
Windows XP: When a window appears allowing you to select 
an application program to start, select [View/Download 
Images using Canon CameraWindow] and click [OK]. 

The Camera Control window opens.

Specify the file name at which 
to save the images.

Specify the settings of the folder 
and subfolder.
19Downloading Still Images (ZoomBrowser EX)
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 3 Select a downloading method.
• [Starts to download images]: The progress bar will be displayed and images 

will be downloaded to the computer, and ZoomBrowser EX starts. For 
instructions on how to set the Auto-download settings, see Auto-Downloading 
Settings ( 14).

• [Lets you select and download images]: The CameraWindow opens, 
displaying the camcorder images as thumbnails (small images).

Using the Camcorder to Download Still Images (Direct 
Transfer Function)

If your camcorder supports the Direct Transfer Function, you can use the 
camcorder to download images.

Direct Transfer

1 Select a transfer option on the camcorder screen and press 
the  button.

• See your camcorder instruction manual for how to set and operate the 
camcorder to transfer images.

• For instructions on how to change the destination folder and the folder name, 
see step 3 ( 15) in Auto-Downloading Settings.

• The  button cannot be used when it is not lighted.
• You can set the action that is carried out for direct transfer. Right-click the 

[CameraWindow(Launcher)] icon on the taskbar and select an action from the 
displayed menu.
- [Show image(s) in fullscreen mode]: 

Displays downloaded images in 
full screen mode.

- [Launch ZoomBrowser EX]: 
Starts ZoomBrowser EX after 
downloading the images.

- [Show Window]: 
The Camera Control window 
appears when you connect the 
camcorder to the computer.

2 Press the  button on the camcorder.
0 Downloading Still Images (ZoomBrowser EX)
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Setting the Direct Transfer Download Destination Folder

1 In the Camera Control window, click the [Acquire Images] 
tab and click [Preferences].

2 Select [Change direct transfer download destination folder] 
and click [Next].
21Downloading Still Images (ZoomBrowser EX)
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3 Specify the destination folder settings and click [Finish].

Click this button 
to specify the 
destination folder.  

Destination Folder  

Select to specify  
the name of the 
subfolder.
2 Downloading Still Images (ZoomBrowser EX)
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ZoomBrowser EX Windows
This section explains the windows of ZoomBrowser EX. If you wish to start 
ZoomBrowser EX without connecting the camcorder or card reader/writer, double-
click the  on the desktop, or click the Windows [start] menu and select [All 
Programs]  [Canon Utilities]  [ZoomBrowser EX] and [ZoomBrowser EX]. To exit 
ZoomBrowser EX, click  or select [Exit] from the [File] menu.

Main Window
ZoomBrowser EX’s Main Window features various buttons and a still image display 
area.

1 Task Area
[Acquire & Camera Settings]: Use this to display the Camera Control window to 

download still images and configure the 
camcorder settings.

[View & Classify]: Use this to view and organize still images.
[Edit]: Use this to edit still images.
[Export]: Use this to change the data for still images and 

save them as new files, back up to CD-R/RW, or 
export shooting properties to a text file.

[Print]: Use this to print selected still images.
[Internet]: Use this to attach selected still images to E-mail 

messages.

1 

2 

3

  4

  6

  5
23ZoomBrowser EX Windows
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2 Folders Area
You can select a folder to be displayed in the Browser Area. Selecting the 
[Favorite Folders] tab shows only the folders that are registered as Favorites. 
To register folders as Favorites, follow the instructions below.

To remove the registered folder, select the folder, and click [Remove].

3 Browser Area
This area displays the still images contained in the selected folder.

Clicking on 2 still images while holding down the [Shift] key selects also all 
images between the 2 images.
Clicking on different still images while holding down the [Ctrl] key selects 
multiple images.

4 Browser Area Tool Bar
The menu items vary depending on the View Mode.

When the [All Folders] tab is selected:
Select a folder and click [Add to Favorites].
When the [Favorite Folders] tab is selected:
Click [Add] and select a folder.

1 Previous/Next Displays the previous/next still image in the current folder.
2 Up Displays the folder in the upper tiers of the hierarchy. 
3 Select Allows you to select all still images and deselects still 

images.
4 Information Allows you to select the information to be shown.
5 Zoom Slider Enlarges/Reduces the thumbnails in the Browser Area.
6 Show Allows you to select displayed still images according to 

the star rating.

1 2 3 4 65
4 ZoomBrowser EX Windows



E

W
in

do
w

s

DIGITAL VIDEOV19WENG N.book  Page 25  Thursday, June 30, 2005  7:39 PM
5 View Mode
You can select the view mode of still images in the Browser Area.
[Zoom Mode]: The still images in the selected folder are shown as thumbnails.

[Scroll Mode]: Thumbnails of the still images are displayed next to the folder 
name. Clicking a folder displays enlarged images. Selecting [Preferences] 
from the [Tools] menu opens the [Preferences] window, on which you can 
select the hierarchy of folders.

[Preview Mode]: A large still image is displayed along with detailed information. 
You can change file name and comments. To display another image, click 
[Previous]/[Next] or select an image shown at the bottom of the window.
25ZoomBrowser EX Windows
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6 Application Tool Bar

1 View Image Displays a selected still image in the [Image Viewer] 
window.

2 Properties Displays properties of the selected still image. When you 
select a different image while the [Properties] window is 
open, the information switches to the one of the selected 
image.
The [Properties] window cannot be displayed in [Preview 
Mode].

3 Slide Show Displays still images in a slide show.
4 Search Allows you to search for still images ( 33).
5 Delete Deletes selected still images.
6 Rotate Rotates selected still images.

1 2 3 4 5 6
6 ZoomBrowser EX Windows
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[Image Viewer] Window
The [Image Viewer] window appears when you select a still image and click 
[View Image] or double-click an image.

1 Previous/Next Displays the previous/next still image in the current folder.
2 Edit Allows you to perform red-eye correction, image 

correction, trimming or to register external image editing 
applications. This button cannot be activated when 
multiple still images are selected.

3 Show Allows you to display multiple still images at the same 
time.

4 Synchronize Synchronizes the View functions across all displayed still 
images.

5 Zoom In/Zoom Out Enlarges/decreases a still image.
6 Pan When the still image is larger than the window, you can 

move the image in the desired direction.
7 Auto Focus Frame This function cannot be used for the still images recorded 

by the camcorder.
8 Fit to Window Matches the still image size to the size of the Image 

Viewer Window.
9 Zoom Slider Allows you to enlarge/decrease the displayed still image.
10 Show Image Full 

Screen
Displays a still image in full screen size.

11 Change the Star 
Rating

Allows you to change the star rating.

8
9

10

11

1 2 3 4 5 6 7
27ZoomBrowser EX Windows



2

DIGITAL VIDEOV19WENG N.book  Page 28  Thursday, June 30, 2005  7:39 PM
[Red Eye Correction] Window
Click the  icon located at the top of the [Image Viewer] window and select 
[Red Eye Correction] to correct the red eye effect on a still image in the [Red Eye 
Correction] window.

[Image Correction] Window
Click the  icon located at the top of the [Image Viewer] window and select 
[Image Correction] to change the brightness, saturation, contrast, and RGB of 
the still image.

[Trim Image] Window
Click the  icon located at the top of the [Image Viewer] window and select 
[Trim] to crop a still image. Either drag the mouse on the image or specify the 
cropping area, and click [Trim Image].

1 Auto Mode Clicking [Start] corrects the red eye effect automatically.
2 Manual Mode Point the cursor on a red eye so that the area is 

highlighted green, and left-click the mouse.

 1

 2
8 ZoomBrowser EX Windows
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Organizing Still Images

Applying Star Ratings and Keywords
This task allows you to apply ratings to your images from one star to three stars. 
The Star Rating can be used as one of the search conditions, or for the selection 
of images to be displayed in the Browser Window. The keyword can be used as 
one of the search conditions.

1 Select the image to which you wish to apply the Star Rating 
or Keyword, and select [View/Modify Keywords] from the 
[Tools] menu.

2 Place a check mark next to the keyword you wish to apply, 
or click on the stars for rating.

The default setting of the Star Rating is two stars.
You can display images according to Star Rating by selecting [Filter by Star 
Rating] from the [View] menu.
You can add and delete keywords, or change the keyword list in the [Manage 
Keywords] window by selecting [Manage Keywords] from the [Tools] menu.
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Classifying the Still Images
This task allows you to classify selected images according to the shooting date.

1 Click [View & Classify] in the Main Window.

2 Click [Classify into Folder].

3 Select the images you wish to classify and click [Specify 
Classification Settings].
0 Organizing Still Images



E

W
in

do
w

s

DIGITAL VIDEOV19WENG N.book  Page 31  Thursday, June 30, 2005  7:39 PM
4 Specify the settings and click [Finish].
The selected images are classified into the specified folder.

Renaming Multiple Files
This task allows you to rename multiple files at the same time, or to rename and 
copy multiple files.

1 Click [View & Classify] in the Main Window.

2 Click [Rename Multiple Files].
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3 Select the still images you wish to rename and click [Specify 
Rename Settings].

4 Specify the settings and click [Finish].

To rename a folder, select a folder, and open the [Rename Folder] window by 
selecting [Rename] from the [File] menu. Input the new name, and click [OK].

Placing a check mark here makes copies of still images with new names.  
The name of the original images will not be changed.
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Searching for Still Images
This task allows you to search for images by Star Rating, Modification Date, 
Shooting Date, Comment or Keywords.

1 Click [View & Classify] in the Main Window.
You can also search for images by clicking [Search] on Application Tool Bar. 
Please skip forward to step 3.

2 Select folders and images from which you wish to search 
and click [Search].
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3 Specify the search conditions and click [Start Search].
• The search results are displayed as thumbnails.
• Select at least one search condition.

4 Click [Finish].
• To change the search parameters and perform another search, click [Specify 

Search Conditions] and repeat steps 3-4.
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• The images of the search result are displayed in the [Search Results] folder. 
You can print or copy these images to another folder. The images will remain 
in this folder until ZoomBrowser EX is closed or another search is performed.
35Organizing Still Images



3

DIGITAL VIDEOV19WENG N.book  Page 36  Thursday, June 30, 2005  7:39 PM
Exporting Still Images
This task allows you to change the size, resolution or data for of selected still 
images and save them as new files and allows saving the shooting properties of 
the still image to a text file or copying the still images with new names. 
Furthermore, you can export still images for use as a screen saver or a 
wallpaper.

Changing the File Type and Save

1 Click [Export] in the Main Window.

2 Select the export type.

When you have selected [Backup to CD], see Saving on CD-R/RW Discs 
(Windows XP Only) ( 39).
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3 Select images and click [Specify Export Settings].

4 Specify the export settings and click [Finish].
The window varies depending on the selected export type in step2.

When you have selected [Export Still Images]:
You can convert still images to another file type, resize and save them as new 
files. You can select the file type from BMP, JPEG and TIFF. You can also specify 
a prefix to be added to the exported still images.
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When you have selected [Export Shooting Properties]:
You can select the information you wish to export and save as a text file.

When you have selected [Export as a Screen Saver]:
You can export and save the image as a screen saver.

When you have selected [Export as a Wallpaper]:
You can export and save the image as Windows wallpaper. This task cannot be 
performed if you have selected multiple images.
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Saving on CD-R/RW Discs (Windows XP Only)
You can copy and save still images to CD-R and CD-RW discs. The shooting 
information is copied along with the images.

This function can only be used on a computer that came with a CD-R/RW drive 
as standard equipment.

1 Place a CD-R/RW disc in the computer’s CD-ROM drive.

2 If the following window appears, click [Cancel].

3 Click [Export] in the Main Window.
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4 Click [Backup to CD].

5 Select the folders or still images you wish to save and click 
[Specify Backup Settings].
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6 Set the backup settings and click [Start Backup].
The disc will be ejected from the drive when copying is complete.

You can add still images to a CD-R/RW disc that already contains images.

Adding Still Images from Your Computer to the Memory Card
You can save still images (JPEG) from the computer to a memory card of the 
camcorder and a card reader/writer. You can also save sample images for card 
mix from the DIGITAL VIDEO SOLUTION DISK.

Unable to upload the still images to the disc.

Adding Still Images to the Memory Card

1 Connect the camcorder to the computer ( 10).

2 Click [Acquire & Camera Settings] in the Main Window.
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3 Click [Set to Camera].

4 Click [Uploads images to the camera].

5 Select the still images you wish to save and click [Open].
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6 Select the image size and click [Add].

When you upload images edited with another application, image properties 
may be lost.

Adding Sample Images to the Memory Card
You can save sample images for card mix to the memory card of the camcorder 
and a card reader/writer. CARD CHROMA, CARD ANIMATION, CARD 
LUMINANCE and CAMERA CHROMA are provided on the DIGITAL VIDEO 
SOLUTION DISK.

The sample images provided on the supplied DIGITAL VIDEO SOLUTION 
DISK are intended only for personal use with this camcorder. Do not use 
these sample images for other purposes.
Unable to upload the sample images to the disc.

1 Connect the camcorder to the computer ( 10).

2 Insert the DIGITAL VIDEO SOLUTION DISK to the 
computer’s CD-ROM drive.

If the installer panel opens, click [Exit] to close it.
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3 Click [Acquire & Camera Settings].

4 Click [Set to Camera].

5 Click [Uploads images to the camera].
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6 In [Look in:], select the CD-ROM icon, and double-click [DVC 
CARD IMAGE].

Sample images or folders for CAMERA CHROMA, CARD ANIMATION, CARD 
CHROMA and CARD LUMINANCE appear.

7 Select the sample images you wish to save and click [Open].

8 In the Add image window, click [Add].
The sample images are saved in the memory card.
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Using Various Functions

Attaching Still Images to E-mail Messages
You can attach selected still images to an E-mail message.

To use this function, the e-mail software must be enabled as MAPI client. For 
details, refer to the instruction manual of the e-mail software.

1 Click [Internet] in the Main Window.

2 Click [Email Images].

3 Select the still images you wish to send and click [Change 
Image Size].
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4 Select image size and quality, and click [Send or Save].
If you wish to send the still image without changes, select [Send images 
unchanged]. Normally select [Resize and compress images into JPEG].

- [Resize image]: Select the reduction ratio to the original still image.
- [Image quality]: The lower the quality, the coarser becomes the still image 

and smaller the file size. 
- Pressing [Apply] displays the file size after the compression as [Total size of 

changed images].
- You can check the compressed still image by pressing [View Images].

5 Select to send still images by e-mail or to save the still 
images in a folder and click [Finish].

• If you selected [Create a new email], your e-mail software starts and the 
selected still images appear as an attachment in the message window. Input 
address, subject and your comments and send the message. E-mail software 
not supporting MAPI does not start automatically. In this case, select [Save the 
images in a folder...].

• If you select [Save the images in a folder...], click [Browse] and select the 
destination folder. Start your e-mail software and attach the saved still image 
to a message.
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Running a Slide Show
You can view selected still images in a slide show.

1 Click [View & Classify] in the Main Window.
You can also view a slide show by clicking [Slide Show] on Application Tool Bar. 
Please skip forward to step 4.

2 Click [View as a Slide Show].

3 Select the still images and click [Setup Slide Show].
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4 Select the slide show settings.
• [Image Size]: Select the size of the still images.
• [Image Information]: Select to show still image information such as file name 

or title.
• [Advance to Next Slide]: Select to advance manually or automatically. When 

you select “Every 3 seconds”, you can select the interval in the control below 
(from 1 to 120 seconds).

• [Loop]: Select to stop the slide show after the last still image or to continuously 
run it in a loop.

• [Effect]: Select the transition effect to be used when moving from one slide to 
another. When you click an effect, you can check the effect in the preview 
window. 

5 Click [Start Slide Show].
Click  in the lower right corner to end the slide show.
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Merging Panoramic Images (PhotoStitch)
You can merge a series of overlapping still images into a single, seamless 
panorama. PhotoStitch automatically arranges still images recorded with the 
camcorder’s Stitch Assist mode in their correct order and orientation, making it 
easy to merge them. Please refer to the Camcorder Instruction Manual to learn 
how to record in Stitch Assist mode.
The following instruction explains how to merge still images recorded in Stitch 
Assist mode with the camcorder.

Still images recorded in Stitch Assist mode with Wide-converter or Tele-
converter attached cannot be merged correctly.

1 Select still images shot in Stitch Assist mode.
To use PhotoStitch, images need to be shot in Stitch Assist mode. To download 
images, please refer to Downloading Still Images (ZoomBrowser EX) ( 12).
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2 Click [Edit].

3 Click [Stitch Photos].
PhotoStitch starts.

4 Arrange the order of the still images and click [2. Merge].
Operational instructions are displayed in the upper section of the window.
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5 Click [Start].

6 Select [3. Save] and then click [Save].
• Select the destination folder, input the file name and click [Save].
• In the View the Saved Image? window, click [Yes]. The Viewer window opens 

and displays the merged image.
• To exit PhotoStitch, from the [File] menu, select [Exit].

You can record the surroundings in 360 degrees, and stitch them together 
later to form a 360-degrees cylinder. (In [1. Selection and Arrangement], 
select [Arrange] and [360 Degrees].) By saving this stitched image in 
QuickTime VR type, you can then get a virtual view of the surroundings by 
manipulating the mouse. For this, you need to have QuickTime installed on 
your computer.  If it is not already installed, install it from the DIGITAL VIDEO 
SOLUTION DISK. Place the disc in the CD-ROM drive and click QuickTime 
[Install] in the installer panel.
Please refer to the PhotoStitch Help menu for more details.
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Printing Still Images (PhotoRecord)
PhotoRecord is a printing program. You can use this program to lay out the still 
images for printing. You can also create original albums and save them to your 
computer. Movies cannot be printed.

Do not open the memory card cover, remove the memory card, detach the 
USB cable or turn off the camcorder while data is being transferred to the 
printer (when the camcorder’s access indicator is flashing). Doing so may 
cause memory card data to become corrupted.
If you are using a network printer and the printer name (including the 
network path) exceeds 31 characters, it may not be possible to print from 
PhotoRecord. If this happens, click the [Printers and Other Hardware] 
followed by [Printers and Faxes] from the Windows [Control Panel] and 
change the name of the printer, limiting its length to within 31 characters.

1 Click [Print] in the Main Window.

2 Click [Layout Print].
When you wish to print an index, select [Contact Sheet Print].
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3 Select the still image you wish to print and click [Select 
Captions for Printing].

4 Select the image information you wish to include in the print 
and click [Open Layout Print].

• Place a check mark beside the items you wish include in the print.
• If you wish to add a comment, select a still image and enter a comment in the 

Properties window by clicking  (Properties). 

5 Click [2 Select Printer & Album Type] and select a printer 
and album type.

Select the album type.

Select the printer.
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6 Click [3 Select Paper] and select the media type, paper size 
and page orientation.

• If you click [Decorate Album], you can change the theme (a consistent design 
for background, photo frames and text frames), or set the design elements 
individually. When you set the design elements individually, make sure to 
select the target page.

• If you click [Add Titles & Captions], you can add titles and text, and change 
font, font size, justification and color. Make sure to select the target page when 
performing these changes.

7 Click [4 Print], confirm the number of copies and other print 
settings, and click [Print].

Printing starts.

PhotoRecord automatically performs image correction for still images shot with 
Exif 2.2 compatible camcorders and even other images, yielding high-quality 
prints. 

Set the paper type and orientation.
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Adding Sound to a Still Image
You can add a sound to an image. The sound file needs to be in WAVE format 
(extension “.wav”) or in MIDI format (extension “.mid” or “.midi”).
The sound cannot be played back on the camcorder.

1 In the Main Window, select an image and select [Add/
Remove Sound] from the [Edit] menu.

2 Click [Add]. 

3 Select the sound file and click [Open].

4 Click [OK].
• The sound file will be copied to the same folder as the image. 
• To play back the sound, select an image with a sound icon and select [Play 

Sound] from the [Edit] menu.

To remove sound from an image, select [Remove] on the Sound window in 
step 2.  disappears and the copied sound file will be deleted.
The [Play Sound] window appears and plays back the sound.
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Applying DPOF Settings
You can select still images and the number of prints for automatic printing on a 
DPOF (Digital Print Order Format)-compliant printer. You can set the DPOF print 
settings for the still images on the card also on the camcorder.

DPOF print settings cannot be applied to still images recorded on the disc.
The [Edit Slide/DPOF] window allows print settings on up to 998 still images. 
With some camcorders, DPOF print settings are limited to a maximum of 200 
still images. In that case, all DPOF print settings on the 201st still image and 
onward will be erased.
If 999 or more still images are recorded on a memory card, the [Edit Slide/
DPOF] window may not operate properly. To set the number of prints, reduce 
the number of images on a memory card to 998 or less.

1 Connect the camcorder to the computer ( 10).

2 Select [Canon CameraWindow] and click [OK].
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3 Click the [Set to Camera] tab and click [Set Slide Show/
DPOF].

• When connecting a card reader/writer, click the [Set to Memory Card] tab and 
click [Set Slide Show/DPOF].

• The slide show function of the camcorder cannot be used. 

4 Click [Print Order(DPOF)] and select a print type from the 
drop-down list.

• [Standard Print]: Prints selected still images in the specified number of copies. 
Use the arrows next to the boxes to select the number of copies.

• [Index Print], [Both (Standard/Index)] and the option [Titles] of the [Edit] menu 
(printing of date and file number) are not supported by the camcorder.
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5 Select the still images you wish to print and the number of 
copies.

6 Click [Save to Camera].
The DPOF print settings will be saved to the memory card.
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Reviewing and Changing the Settings of the Camcorder
You can adjust the date, time and owner settings of the camcorder. You can also 
check the remaining memory card capacity or format the memory card.

1 Connect the camcorder to the computer ( 10).

2 Select [Canon CameraWindow] and click [OK].

3 Click the [Set to Camera] tab and click [Confirms/changes 
camera settings].
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4 Change the settings of the camcorder and click [OK].

The disc in the camcorder cannot be formatted.

Input a camcorder owner name 
here (up to 31 characters).

Set the date and time here.

Click this button to synchronize 
the camcorder to the computer’s 
date and time settings.

Click this button to format the 
memory card in the camcorder.

Check the remaining disc or 
memory card capacity here.

Check the power status here.
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Uninstalling the Software
Uninstall the software when you wish to delete it from your computer or when 
reinstallation is required to fix corrupted files.

Users of Windows 2000 and Windows XP must first log in as an Administrator 
to uninstall the driver and other programs. 

Uninstalling ZoomBrowser EX

1 Click the Windows [start] menu and select [All Programs]  
[Canon Utilities]  [ZoomBrowser EX] and [ZoomBrowser 
EX Uninstall].

The uninstall utility starts and removes ZoomBrowser EX. 

Uninstall all programs in [Canon Utilities] when you have uninstalled 
ZoomBrowser EX.
When uninstalling CameraWindow, please uninstall it in the following order:

1) [CameraWindow] in the [EOS Digital] folder
2) [CameraWindow DC_DV x] in the [PowerShot xxxxx] folder
3) [CameraWindow MC x] in the [CameraWindow] folder

PhotoRecord and PhotoStitch can be removed with the same procedure.
RemoteCapture Task and RAW Image Task are used with Canon digital 
cameras. The camcorder does not support these programs.
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Uninstalling the TWAIN Driver/WIA Driver
Users of Windows XP do not need to uninstall the driver.

1 Connect the camcorder to the computer ( 10).

2 If a window for selecting an application program or the 
Scanners and Cameras Wizard appears, click [Cancel]. If 
ZoomBrowser EX started, close it.

3 Click the Windows [Start] menu and select [Settings] and 
[Control Panel].

4 Double-click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see TWAIN Driver/WIA 
Driver Uninstallation ( 65).

5 Windows 98/Windows 2000: 
1. Delete [Canon Camera] from the [Scanners and Cameras Properties] list.
2. Click [OK] to close the window.
3. Turn the camcorder power switch to OFF and remove the USB cable from the 

computer.
4. Click the Windows [Start] menu and select [Programs], [Canon Utilities], [DV 

TWAIN Driver x.x] and [TWAIN Driver Uninstall].
A version number appears in place of “x.x”.

Windows Me: 
1. Delete the camcorder icon from the [Scanners and Cameras] folder.
2. Click [OK] to close the window.
3. Click the Windows [Start] menu and select [Programs], [Canon Utilities], 

[DV WIA Driver x.x] and [WIA Driver Uninstall].
A version number appears in place of “x.x”.

6 When the Confirm Uninstall window appears, click [OK]. 
The uninstall process starts.

7 When the Maintenance Complete window appears, click 
[Finish].
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Troubleshooting
Connection

 Camcorder is not recognized when connected to the computer.
Computer does not support the USB interface.
The USB interface is not supported for computer not in compliance with the 
following requirements. Acquire the necessary system to use the USB 
interface.
Requirements: Built-in USB port on a system pre-installed with Windows 
98, Windows Me, Windows 2000, or Windows XP.
There is no disc or memory card in the camcorder.
Insert a disc or a memory card into the camcorder.
The camcorder is not set to the correct mode.
Turn the power switch to PLAY and move the /  switch to . Next, 
select [DISC] or [CARD] in the SYSTEM SETUP menu.
Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ( 10) and check the 
connection. 
Ensure that you are using the correct cable and that its connectors are in 
good shape.
If you are experiencing operational problems, detach the USB cable from 
the camcorder and computer and terminate the connection. Restart the 
computer and the camcorder, and then reconnect the camcorder.
TWAIN Driver or WIA Driver is not installed properly.
First uninstall the TWAIN/WIA Driver, then reinstall the driver from the 
DIGITAL VIDEO SOLUTION DISK (remove the check marks from the other 
programs when prompted to select the programs to be installed).

ZoomBrowser EX Operation
 Cannot download still images

The camcorder it not set to the correct mode.
Turn the power switch to PLAY and move the /  switch to . Next, 
select [DISC] or [CARD] in the SYSTEM SETUP menu.

Still image files or folders do not appear in ZoomBrowser EX.
Still images of folders shown in ZoomBrowser EX and the actual file 
contents may be different when an image file has been moved or copied 
using Windows functions or edited with a separate program.
Click the [View] menu and select [Refresh Current Folder].

Driver Installation
Cannot install the TWAIN Driver/WIA Driver correctly.

Does the system have a built-in USB port and did it come with Windows 
98/Windows Me/Windows 2000 preinstalled?
Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ( 10) and check the 
connection. 
Ensure that you are using the correct cable and that its connectors are in 
good shape.
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Are you using the power adapter to power the camcorder?
If the problem is not mentioned above, the TWAIN Driver/WIA Driver may 
not have been recognized by Windows. 
Uninstall and reinstall the driver.

TWAIN Driver/WIA Driver Uninstallation
If you had problems uninstalling the driver, use the following procedures to 
remove it.

The [Inf] folder contains numerous files that are critical to the computer’s 
operation. Be extremely careful not to delete the wrong files. If you delete the 
wrong file, you may be unable to restart Windows.

Use the procedures below for the following circumstances too.
- If you do not find [Scanners and Cameras] in the [Control Panel] or 

[Printers and Other Hardware].
- If [Canon Camera] or your camcorder model name does not appear in the 

[Scanners and Cameras Properties] or [Scanners and Cameras].
- If you connected the camcorder to the computer via the USB cable before 

installing the Digital Video Software.

Leave the camcorder connected to the computer.

1 Click the Windows [Start] menu and select [Settings] and 
[Control Panel].

2 Double-click the [System] icon.
The [System Properties] dialog appears.

3 Click the [Device Manager] tab.

4 If [Canon Camera] appears under the [Other Devices] and/or 
[Imaging Devices] categories, use the following procedures 
to delete it.

1. Select [Canon Camera] and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5 Double-click the [My Computer] icon on the desktop 
followed by the [C:] drive and the [Windows] and [Inf] 
folders.
If the [Inf] Folder Is Not Visible in the [Windows] Folder

1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.
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3. Windows 98: Set the [Hidden files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show hidden 
files and folders].

4. Click [OK].
This makes the [Inf] folder and files in the [Inf] folder visible.

6 Find and delete the [Drvdata.bin] and [Drvidx.bin] files.

7 In the [Inf] folder, double-click [Other] folder to open it.

8 Find and delete the [Canon.IncCAPxxx.inf] and 
[Canon.IncCDVxxx.inf] file.

• The xxx represents numerals.
• If the above file is not contained in the [Other] folder, you do not need to delete 

anything.

Leave the camcorder connected to the computer.

1 Click the Windows [Start] menu and select [Settings] and 
[Control Panel].

2 Double-click the [System] icon.

3 Click the [Hardware] tab.

4 Click the [Device Manager] button.

5 If [Canon Camera] or your camcorder model name appears 
under the [Other Devices] and/or [Imaging Devices] 
categories, use the following procedures to delete it.

1. Select [Canon Camera] or the name of the camcorder model, right-click 
the mouse button and select [Delete].

2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

Remove all copies of [Canon Camera] or your camcorder model name 
that appear in the [Other Devices] or [Imaging Devices] categories, or 
that appear more than once in one category.
6 Troubleshooting
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6 Double-click the [My Computer] icon on the desktop, 
followed by the [C:] drive, and the [Winnt] and [Inf] folders.
If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedures to show all files and folders.
1. Click the [Tools] menu and select [Folder Options].
2. Click the [View] tab.
3. In the [Advanced setting] section, set the [Hidden files and folders] 

category to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check 
mark.

4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.

7 Look for the file for Canon digital camcorders starting with 
[Oem*].

• A number such as “0” or “1” will appear in place of the asterisk (*) above. You 
will also find another file called [Oem*.pnf], which will have the same number 
as the [Oem*.inf] file. The two constitute one set.

• There may be many file sets starting with “Oem”.
• If you double-click an [Oem*.inf] file, the Windows Notepad program will start 

and show the file contents. Click each [Oem*inf] file until you find one that 
contains “*** Canon Camera Driver Setup File***” in its first line. When you 
find the correct file, note down its name and close the Notepad window.

8 Delete the [Oem*] file set.
Delete all [Oem*.inf] and [Oem*.pnf] files, taking great care to delete the correct 
files.

If You Were Using ZoomBrowser EX Version 2 or 3 
(This manual explains version 5.x)

 Titles and comments added using a prior version than ZoomBrowser EX 
version 4 do not appear in ZoomBrowser EX 4 or higher.

Titles and comments added using a prior version of ZoomBrowser EX will 
not be displayed. Use the following procedure to display them.
1. In Windows Explorer, open the [Program] folder under the folder in which 

you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program).

2. Double-click [dbconverter.exe].
3. Select the database you were using until now (C:\Program Files\Canon\

ZoomBrowser EX\Program) and click the [Start] button.
Please note that with ZoomBrowser EX 4 or higher, both titles and 
comments appear in the comment list.

 Cannot find the still image folders saved with a prior version than 
ZoomBrowser EX 5.x.

Still image folders saved under the [Program Files] folder (such as [Image 
Library One]) cannot be displayed in the Main Window’s Folder Area of 
ZoomBrowser EX 4 or higher. Use the following procedure to display 
them.
67Troubleshooting
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1. In Windows Explorer, open the [Program Files] folder under the folder in 
which you installed ZoomBrowser EX 4 or higher (C:\Program Files\
Canon\ZoomBrowser EX\Program\Image Library One).

2. Select the still image folder you wish to display and copy the folder to a 
different destination.
8 Troubleshooting
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